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An Introduction To Video Editing

Matthew J. Sudol, Media Developer for ProMedia, the Professional
Media Services, Inc., will share his knowledge about video editing

with us on Tuesday May 6 .th

He will cover the basics of digital video editing from selection of hardware
(encoders and capture devices) and software (video production suites like
Adobe Premiere and ULead Video Studio) to editing techniques that you
can apply to your specific application. He will cover input
formats ranging from Mini DV, DVD, VHS and more to final
formats, for example converting your old home movies on
VHS to a DVD, or producing your footage from your digital
camera for display on the web, such as YouTube.

Matt is a graduate of SUNY College, Cortland. During his tenure there Matt worked for Academic
Computing Services as a computer technician and held a position as DJ on 90.5 WSUC-FM.

In 2001 Matt became the lead web designer for a nationally recognized outdoor sporting retail
store. During his time there Matt became involved with photography and videography involving
outdoor recreation, specifically whitewater kayaking.

In August of 2005 Matt joined Professional Media Services, Inc. as a Media Developer. Since then
he has had the opportunity to work with and learn from top professionals in the video production and
editing industry. Matt has since produced hundreds of television commercials, 30 minute television
shows and several interactive and feature length DVD's. Matt attributes his ability and success in the
industry to a versatile understanding of all aspects of video production, from cameras, camera

equipment and filming to computer hardware, software and peripherals. �
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The MVPCUG EXPLORER is published monthly from

September through June by the Mohawk Valley Personal Computer

User Group, Inc.(MVPCUG), PO Box 586, Marcy NY 13403-0586.

Opinions expressed herein are the writers and are not reflective of

the MVPCUG, nor are they considered substantiated by inclusion in

this newsletter. All articles are copyrighted by their respective authors

but may be reprinted by other User Groups provided credit is given

to the author and this publication.

The. MVPCUG was founded in 1981 by individuals interested in

IBM compatible computers. This non-profit organization consists of

volunteers whose expertise range from novice to professional.

Regular meetings are held on the first Tuesday of the month at

6pm, usually at the Whitesboro High School, Route 291, Marcy NY.

A typical agenda consists of discussion of business affairs and a

demonstration of computer related products.  Meetings are open to

the public.

Initial membership fee for an individual is $25. Annual renewal
dues are $20.

OFFICERS and DIRECTORS

President

Jerry Finkelstein . . . . . . . . . . . . . . . . . . . . . 797-5296

. . . . . . . . . . . . . . . . . . . . demetrius28 at adelphia.net

Vice President

Lisa Britt . . . . . . . . . . . . . . . . . ydaith at hotmail.com

Treasurer

Bill Gorrell . . . . . . . . . . . . . . . . . . . . . . . . . 853-3256

. . . . . . . . . . . . . . . . . . . . lwgorrell at roadrunner.com

Secretary

John Hunter . . . . . . . . . . . . jhunter1 at twcny.rr.com

Directors-at-Large

Helen Russell [‘08] . . . . . . . . . . hrcnb at capital.net

Jim Pease [’09] . . . . . . jamesrpease at yahoo.com

Lou Barile [‘10] . . . . . . . . . . . . . l.barile at verizon.net

Our internet presence is at

h t t p : / / w w w . m v p c u g . c o m
Web Master

Lisa Britt . . . . . . . . . . . . . . mvpcug@usadatanet.net

NEWSLETTER STAFF

Patricia Bruno . . . . . . . . . . pbruno315 at gmail.com

Jerry Finkelstein . . . . . . demetrius28 at adelphia.net

Donna Gorrell . . . . . . . . dgorrell at roadrunner.com

John Hunter . . . . . . . . . . . . jhunter1 at twcny.rr.com

Bob Schaffer . . . . . . . rdschaffer at roadrunner.com

Editorial notes . . .
   Adobe has launched a public

beta of its web-based Photoshop
Express image editor for those

consumers who want to touch up
their photos and share them with

friends online. The service offers
users 2 gigs of online storage, but limits photos to less

than 4,000 pixels in height + width or 10 mgs.
   Basic editing functions include red-eye removal, auto

correct, crop + rotate. Filters add highlights, soft
focus, saturation and sharpness.

   You must set up an account to use the service, but
once logged in you can allow the service to connect to

sites like Picasa, Photobucket, and Facebook.
   Image editing is Flash based, so you need to have

that installed; also a computer running Windows XP or
Vista or Mac OS 10.4.

Www.photoshop.com/express 

Meeting Agenda

5:30 . . . . . . . . . . . . . . Meet and Greet
6:00 . . . . . . . . . . . . Business Meeting
6:30 . . . . . . . . . . . . . . Program, Part 1
7:10 . . . . . . . . . . . . . . . . . . . . . . Break
7:20 . . . . . . . . . . . . . . Program, Part 2
8:00 . . . . . . . . . . . Drawing for Prizes
8:15 . . . . . . . . . . . . . . . . Adjournment

mailto:mvpcug@usadatanet.net
http://Www.photoshop.com/express
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The MVPCUG general meeting was held at the Whitesboro

HS cafeteria. President Jerry Finkelstein called the meeting to

order at 6:07 PM. There were 36 persons in attendance.

BUSINESS MEETING
President Jerry Finkelstein called the meeting

to order at 6:07 p.m. Jerry delayed the proceedings a
bit to allow the Whitesboro High School Lacrosse
Team meeting also meeting in the cafeteria to finish
their business and leave.

After greeting the membership, Jerry informed
them that the scheduled presenter, Jean Skahan, was
ill and not able to attend the meeting. Jerry then
announced that members Donna Gorrell and Jim
Pease had volunteered to present the final program
in our genealogy series in her place. 

Bill Gorrell gave the treasurer’s report for two
months since the meeting in March had been
canceled due to weather. Bill reported that from
February 1  to March 31 , the club receivedst st

revenues of $466.61 reflecting 22 renewals and one
expired membership renewal, and accrued interest of
$1.61. Two months’ expenses totaled $422.11
reflecting payments for Internet service, printing,
door prizes, postage and office supplies. The
resulting net income totaled $44.50.

Account balances through March 31  for thest

checking account totaled $213.76 and the money
market account totaled $2791.45. The GPO credit
union account which totaled $5.00 was closed due to
a $5.00 assessment charged to the account by the
credit union.

Jerry then introduced member Patty Bruno who
has agreed to serve as the new program chair. Patty
asked the members for feedback so that she will be
able to provide programs of interest to members.
Jerry also announced that Patty will write a monthly
newsletter column featuring local events of interest
to members. 

Patty then asked member Nelson Robinson if he
could help establish a blog for members on the club
web site. Nelson agreed to help.

Finally, Jerry reminded members that if the
Whitesboro School District was closed for any
reason on our regular meeting date, there would be
no meeting. Jerry suggested that members tune to
WKTV for notice of closings. Donna and Bill

Gorrell indicated that they sent e-mails to members
announcing the meeting cancellation, but several
members said that they had not received the e-mails
and came to the school anyway.

At 6:32 Jerry turned over the meeting to Donna
and Jim for their presentation.

PROGRAM
Jim spoke first demonstrating the genealogical

software GenoPro. Jim said his version was a free one
that he had downloaded from CNET.com several
years earlier. Jim indicated he would share his copy
with any member wishing to use this program. After a
45 minutes presentation, Jerry called for a break. Jim
indicated that he started using this program to
document family history for his children. 

After the break Donna resumed the presentation
with a demonstration of her genealogical research
using Roots Magic. Donna demonstrated how she
included photographs in her genealogical charts as
well as her efforts to include other vital statistics in
the charts. During her discussion, Donna urged
members to take high resolution digital photos
whenever possible since the high resolution allows
for much clearer details in the resulting images.
Donna finished her presentation at 8:10 p.m.

DOOR PRIZES
[furnished with club funds]

8 ½ X 11Photo Paper . . . . . . . . . . . . Tony Ciancio
1 Gig Bit Flash Drive . . . . . . . . . . . . . . John Hunter
4 X 6 Photo Paper . . . . . . . . . . . . . . . . Patty Bruno

[donated by Que Books]

Photo Pedia . . . . . . . . . . . . . . . . . . . . Joe Penabad
Power Point 2007 . . . . . . . . . . . . . . . . . . John Dylis

[donated by Peach Pit Press]

My Space . . . . . . . . . . . . . . . . . . . . . Robert Jones
[donated by Judy Wenner]

Word Perfect Office 12 . . . . . . . . . . . Helen Russell

The meeting adjourned at 8:15 PM.

John Hunter, secretary �

HELP HOTLINES

Corel Draw

   Patricia Bruno . . . . . . . . . . . . . . . pbruno315@gmail.com

Hardware

   Bill Gorrell . . . . . . . . . . . . . . . . lwgorrell@roadrunner.com

WordPerfect / Graphic editing

   Donna Gorrell . . . . . . . . . . . . . donna.gorrell@yahoo.com

  Minutes of April 1, 2008
— John Hunter, Secretary  

http://www.CNET.com
mailto:pbruno315@gmail.com
mailto:lwgorrell@roadrunner.com
mailto:donna.gorrell@yahoo.com


  Word Processing Tips
— by Bob Schaffer  
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Placing file name and path in a footer
Headers and footers are areas in the top and bot-

tom margins of each page in a document. You can
add the file name and path of your document to the
header or the footer in a Microsoft Word document. 

Those people who prepare handouts, lessons,
diagrams, certificates, etc . . . and can’t find the file
where the item is stored, will save time and trouble
by simply placing the file name and path of the item
in—I prefer—the footer. I’ll also show you how to do
this unobtrusively, which means making it smaller
and placing it out of the way of the material on your
page(s).

To add the file name and path to the footer in a
Word document, follow these steps:

1. On the View menu, click Header and Footer.
You will see that the header is outlined by
non-printing dotted lines. Below the header
you will see the blue Header and Footer
toolbar.

2. If you want to add the file name and path of
your document to the footer, click Switch
Between Header and Footer on the Header and
Footer toolbar. The third icon to the left of
Close on that bar will do the job for you.

3. Click Insert AutoText on the Header and Foot-
er toolbar, and then click Filename and path. If
you haven’t first saved the file, then AutoText
won’t give you your file name and path.

4. To make the file name and path less obvious
on the page, select (highlight) the item and
choose a smaller size font. I usually go as
small as 8. I also choose a condensed font
(Arial Narrow) to so to make the item even
smaller in appearance.

So there you have it. Now if you want to use this
pattern of steps, turn on your macro command and
“record” each step above. Then, once your page is
saved, simply run the macro and your filename will
appear in the footer in a matter of a couple of
seconds. What could be easier?

And here’s an alternative to the above: To insert
the file name and path into the body of a Word
document (not in a footer), point to AutoText on the
Insert menu, point to Header/Footer, and then click
Filename and path. This will place the item wherever
your cursor was.

Protecting text in the footer
To protect the text that is in the footer (or header)

of a Word document from changes, follow these steps:
1. Open the Word document that contains the

header and the footer that you want to protect
from changes. Do not open the header or the
footer of the document. 

2. Make sure that you are at the top of your Word
document. To do this, press CTRL+HOME. 

3. On the Insert menu, click Break. 
4. In the Break dialog box, click Continuous under

Section break types, and then click OK. 
5. On the Tools menu, click Protect Document. 
6. Use one of the following procedures, depending

on your version of Word:
• In Microsoft Office Word 2003, follow these

steps:
a. In the Protect Document task pane, click

to select the Allow only this type of
editing in the document check box under
Editing restrictions, and then change the
box to Filling in forms. 

b.  Click Select sections. 
c. In the Selection Protection dialog box,

click to clear the Section 2 check box,
and then click OK. 

d. Under Start enforcement, click Yes, Start
Enforcing Protection. 

 • In Microsoft Word 2002 and Microsoft Word
2000, follow these steps:
a. In the Protect Document dialog box, click

to select the Forms check box.
b. Click Sections.
c. Click to clear the Section 2 check box,

and then click OK.
d. Click OK to close the Protect Document

dialog box.

How footers affect margin settings
If the footer (or header) becomes too large verti-

cally to fit in the margin, it starts expanding down-
ward (for the header) and upward (for the footer),
reducing the amount of text that can be displayed in
the body of the document. To prevent this:

1. On the File menu, click Page Setup.
2. Click the Margins tab.
3. Type a hyphen (-) before the Top or Bottom

margin setting.

[This tip courtesy microsoft.com] �



May 2008 | MVPCUG Explorer Page 5

Wireless Fidelity ~ we all know it as Wi Fi.

Today we are a traveling connected society, and we
can’t seem to go anywhere without
that laptop hooked to our hip. If
you are wondering, “ How can I do
that too?,” I  will try to explain.

Within the Mohawk Valley, we
have a lot of restaurants and coffee
shops that have free and fee Wi-Fi.  Here are some
free Hotspots (that’s what they are called) near you.

• Panera Bread ~ Commercial Drive, New Hartford

• Mojo’z Zaffe ~ Albany Street, Utica

• Kirkland Library ~ College Hill Rd., Clinton

• Herkimer Comm. College ~ Reservoir Rd, Herkimer

• Ilion Free Public Library ~ West  Street, Ilion

• KOA ~ Herkimer, Niagara Falls, Cooperstown, NY

www.Koa.com / wireless

If you are interested in finding more HOTSPOTS go
to www.jiwire.com and check it out!!!

Free Wireless Internet Service (Wi-Fi) access is now
available to motorists at all 27 Thruway Travel Plazas
conveniently located along the 641-mile super-
highway. Including I-84. The Wi-Fi system provides
free Internet access to customers who visit the Travel
Plazas with Wi-Fi enabled devices such as a laptop,
cell phone, or personal digital assistant (PDA).
.

Now lets try to get you connected!!!

Let’s presume your laptop is Wi-Fi ready ~ most new
laptops are sold today with a Wi- Fi adapter. 
Connecting to your nearest Hotspot is relatively easy.
Find a location near the back of the room, sometimes
the Wi-Fi signal is weaker as you get closer to the
door.  Open your laptop ~ turn it on, (In Win XP) and
depending on your adapter card, you should have a
computer with 3 waves in the task bar.  Right click on
this icon in the taskbar. You should see > View
available wireless networks. A list will appear unless
you are using a 3  party adapter card, and you are notrd

using Windows to manage your network.> Then you
must connect using the 3  party software. In the list,rd

look for the SSID (access point name) for the location
where you are trying to connect. There is usually a
Wi-Fi sign posted stating the SSID.
Tip: This SSID will be unsecured. After you have
selected the SSID > click connect > connected should
appear. Check the icon in the taskbar for the
connection status.  Mac’s are easier, you select the
SSID from the airport menu ~ it’s that easy!!!

You’re not done!!!

Open a new  window in the browser and this new
screen should be a login screen. This login will allow
you to agree to the terms of the location and walk you
through any type of payment procedure if there is
any. TaDa!! ~ Hopefully that worked!! And
remember, it’s YOUR JOB to secure your
information; make sure your security methods are up
to date.

The Utica Public Library is offering
Free Computer Classes

Introduction to Computer Fundamentals
An introduction to using computers for those with no

prior experience
[Saturdays] May 17 , 24 , and 31   9:30-11:30 amth th st

[Tues + Thurs] June 3 , 5 , 10 , + 12  10:30-12:00 rd th th th

Introduction to Word Processing
Learn the basics of how to use Microsoft Word to

create documents
[Saturdays] May 10   9:30-11:30 amth

[Tues + Thurs] April 29 , May 1 , 6 , and 8th st th th

10:30-12:00

Introduction to the Internet and Email
Learn the basics of how to use the internet as well

email
[Saturdays] May 3rd 9:30-11:30 am

[Mon-Wed + Fri] May 12 , 14   and 16  10:30-12:00th th th

Introduction to Excel
Learn the basics of how to use Excel to create spread

sheets and tables
[Tues + Thurs] May 20 , 22 , and 27  10:30-12:00th nd th

Call Utica Public Library (735-2279) or visit and
sign up at the Information Desk! �

   What’s Happening !!!
— Patricia Bruno   

http://www.Koa.com
http://www.jiwire.com
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If You’re Irish and You Know It . . .
Want to show off your Irish heritage in a physical

way? Click on www.shamrock-tattoos-online.com 
and enter a website devoted to Irish clover and
shamrock tattoo designs for the ethnocentric
exhibitionist. The site hawks an E-book that provides
clover and shamrock designs and Celtic artwork for
use by tattoo artists. All for only $19. The offer
includes $77 dollars of extras. Hurry! Supplies are
limited. Ouch!

It’s Blowin’ In The Wind
The hurricane season is just around the corner.

Travelers wishing to keep abreast of the weather
should visit www.nhc.noaa.gov. This website is the
portal for the National Hurricane Center and provides
visitors with current weather information. The center
provides maps of the Atlantic and Pacific Oceans for
those who wish to track individual storms. There is
even an amateur radio station located on the campus
of Florida International University in Miami
[wx4nhw] devoted to sending out radio hurricane
update alerts when necessary. On the day of my visit,
winds were calm. Smooth sailing, all.

Dirty Air Hurts
For those of us suffering from COPD or other

medical issues, the next site allows people to monitor
air quality in the Northeast through live web cams
and corresponding air monitoring reports of air
quality conditions in urban and rural settings in the
Northeast. Click on www.hazecam.net/ and view live
pictures from Maine to Maryland. At my visit, air
quality remained good except for a portion from
Trenton and South Jersey. 

When I clicked on the Acadia, Maine cam, I found
a live picture of Mt Desert with air quality of low fine
particles and low ozone. When I visited Blue Hill,
Mass. I found a high resolution archived photo from
the day before showing clear skies and the City of
Boston with other area landmarks identified on the
pictures. The landmark farthest away proved to be
Mt. Monadnock in Maine 68 miles distant.

The Newark and New York City cam pictured
medium fine particles and low ozone. A bridge in the
foreground was clear, but the high rises in the
distance were very hazy. The realtime [11:15 a.m.]

image was very impressive. Obviously, the website
provides travelers a way to check for air pollution
beforehand. Cool and helpful.

History is Good Except in School
Women comprise 51 percent of the population and

nearly half of the workforce. Like other groups,
however, the contributions made by women to our
culture and our country are neglected by history
textbooks. For those interested in finding out more
about the contributions made by women, visit
www.roadsfromsenecafalls.net. 

The home page provides links to 2000 web sites
related to women’s history. These sites have been
evaluated and categorized by educators. Retired
SUNY Oswego history professor Judith Wellman 
and Joanne Silverstein of Syracuse University’s
Information Institute earned a $213,000 grant from
the U.S. Dept of Education for the project.

“Roads” resources may be used in classrooms, by
small groups and by individuals of any age. The
purpose is to help K-12 teaches incorporate women’s
history in history and social studies classes and to
raise awareness in general of the many contributions
made by women to American culture.

You can plan real field trips or take electronic field
trips to important sites by clicking on “Field Trips” in
a box located on the left side of the screen. When I
typed in Sybil Ludington, 16-year-old girl who rode
her horse through Dutchess County in 1777 warning
citizens the British were coming, I found a short
biography and a monument site in Danbury, Ct. 

But when I typed in Jogansoseh, the Peace Queen,
who lived in Ganondagon, a historic Seneca village, I
ran into trouble. The site did not provide any
information even though I could choose from colonial
history, 17  century history, 18  century history andth th

so on. I clicked on 4  grade level since NYS Historyth

is taught at that age and adult level to no avail. 
For simple questions the site seems easy to

navigate, but for more esoteric questions, you’ll need
some assistance.

Web Help
Do you know of someone who needs assistive

electronic and information technology? If so, visit
www.washington.edu/accessit/index for links to
searchable databases and Q & As.

Until next time . . . �

   Sites to Visit on the ‘Net
— by John Hunter    

http://www.shamrock-tattoos-online.com
http://www.nhc.noaa.gov.
http://www.hazecam.net/
http://www.wholegrainscouncil.org.
http://www.roadsfromsenecafalls.net.
http://www.washington.edu/accessit/index
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. . . that you could restore the underlined letters in
menus in WindowsXP? That was a convenient feature
of older versions of Windows and served as a shortcut
for keyboard users. You could press the Alt key and
the underlined letter to activate a menu item. It’s still
available, but you must restore the feature. Right
click the desktop, choose Properties, then the
Appearance tab. Click on Effects and uncheck “Hide
Underlined Letters for Keyboard Navigation Until I
Press The Alt Key”. Whew, could Microsoft have
made that a bit longer or complicated?

. . . that Word has some neat shortcuts for selecting
sentences and/or paragraphs? Word uses terminal
punctuation [!, ?, and .] to determine where the
sentence begins and ends. Hold down the Crtl key and
click anywhere in the sentence. You can also move
the cursor to the left margin next to the line and when
the cursor changes from the usual “I beam” to an
arrow pointing right, click to select the entire line. To
select a paragraph, triple click anywhere in the
paragraph. The Crtl key doesn’t work in WordPerfect,
but the other two tips do. In WordPerfect to select an
entire sentence merely double click anywhere within
the sentence.

. . . that you can create folders/mailboxes within
your email program to organize your mail? To do this
in Eudora, right click the top folder “Eudora”. Click
New and name the mailbox [MVPCUG or Tips].
Click OK and the mailbox will appear under Eudora.
You can then save the news from the club or tips, by
month, if you want. Right-click the Tips mailbox and
create mailboxes beneath it for each month. You can
make this filing system as detailed as you like. I have
several mailboxes with folders in each mailbox. My
MVPCUG mailbox contains folders named; news-
letter, thank you, business, and presenters. This
allows me to sort emails into the various folders and I
can find them easily.
   If you’re using Outlook or Outlook Express, the
procedure is similar [Folders are used, not
mailboxes]. In Yahoo, find the word Folders. Click
Add. Hotmail is also easy. Click New | Folder. And
AOL? Click the Read button. In the Mailbox window,
click Manage Mail. Click Saved on My PC | Setup
Folders | Create Folder. �

A couple of days ago some teacher friends of mine

were complaining to one another about their middle and

high school students: “They don’t know how to write.”

They can’t write a carefully structured sentence. A

carefully structured sentence? What’s that? It seems that

the students are too busy text- messaging in class even

though text-messaging in class is forbidden. Indeed, in

many local school classes cell and Iphones are also

forbidden. The student, of course, with no respect for the

rules of the classroom, bring them anyway. So much for

the use of modern technology— it’s the ruin of learning

how to write “a carefully structured sentence.” I don’t get

the reasoning but that’s the

complaint. Years and years ago

the familiar complaint was also

that kids couldn’t write a decent

sentence if their diplomas

depended on it. There must have

been a culprit, but text-messaging

wasn’t it; it was long before its

time. But most of those kids did

graduate and some of those poor

sentence structuring students

became teachers themselves, the current crop of

complainers. When was the last time they looked,

critically, at their own written work?

Some of the necessities of text-messaging are similar to

those of email, but there’s much to email that is peculiar to

its own self. And these two methods of communication are

quite different than those required for letter-writing. Once

upon a time, a time before text-messaging, it was email

that was corrupting our youth’s ability to write well. After

all, wasn’t email the medium of bad writing? Poor word

choices are the accepted norm. Lots of capital letters and

exclamation marks and smilies give the email a kind of

style, a tone that is sure to “inform, influence, inspire.”

Let’s be practical, when do you find time in your very

busy day to write a carefully worded, exclamation-point

free email? Our own Donna does. If you’ve ever received

email from her consider yourself privileged. We’ll have to

get her to tell us how she does it. For most of us though

email permits us to write fast and sloppy. One critic of

email notes its function as “an instrument of speedy,

heedless, communication.” Perhaps the 12-year olds are

indeed the masters of test-messages and email. Instead of

complaining about them perhaps we can get them to give

us a few practical lessons. 

You might want to look up Send: The Essential Guide

to Email for Office and Home, by David Shipley and Will

Schwalbe. It promises to tell us “how to write the perfect

email anywhere.” �

  Did You Know . . .
— Donna Gorrell   

 Byting Remarks
— Jerry Finkelstein   



Video Editing
Tuesday � May 6, 2008 � 6:00 PM � Whitesboro High School
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